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Safety warning notice

/A WARNING! To reduce the possibility of heat-related injuries or of overheating the computer, do not
place the computer directly on your lap or obstruct the computer air vents. Use the computer only on a
hard, flat surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft
surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to
contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer
and the AC adapter comply with the user-accessible surface temperature limits defined by the
International Standard for Safety of Information Technology Equipment (IEC 60950).
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Product description

Category

Description

HP ProBook
4525s UMA

HP ProBook
4525s discrete

Product Name

HP ProBook 4525s Notebook PC

Processors

AMD™ processors

Phenom Il P920 1.6-GHz, 2MB L2 cache (25W)

Phenom Il P820 1.8-GHz, 1.5MB L2 cache
(25W)

Turion Il P520 2.3-GHz, 2MB L2 cache (25W)

Athlon Il P320 2.1-GHz, TMB L2 cache (25W)

V-Series V120 2.2-GHz, 512K L2 cache (25W)

Chipsets

UMA—AMD RS880M

Discrete— AMD RS880MD

Southbridge — AMD SB820

Graphics

AMD Universal Memory Architecture (UMA) graphics
subsystem integrated with shared video memory
(dynamically allocated) (ATI Mobility Radeon HD
4250)

AMD Discrete Graphics ATI M93S3-LP with
Hypermemory support. 512MB DDR3, 800MHz (ATI
Mobility Radeon HD530v configurable via base unit)

Panels

All display assemblies support privacy filter

15.6-in HD LED backlight panel:

1366x768 AntiGlare
1366x768 AntiGlare for webcam
1366%768 BrightView

1366x768 BrightView for webcam




Category Description HP ProBook HP ProBook

4525s UMA 4525s discrete
15.6-in HD LED backlight panel (optional): .
e 1366x768 AntiGlare for webcam and WWAN
e 1366x768 BrightView for webcam and
WWAN

Memory 2 customer-accessible/upgradable memory module . .
slots
Supports dual-channel memory . .
Supports up to 4 GB of system RAM . .
PC3-10600, 1333-MHz, DDR3 . d
Supporis the following configurations in all countries .
and regions:

e 4096-MB total system memory (2048-MB x 2,
dual-channel)

e 3072-MB total system memory (2048-MB +
1024-MB, dual-channel)

e  2048-MB total system memory (2048-MB x 1)

o 2048MB fofal system memory (1024-MB x 2,
dual-channel)

e 1024-MB fofal system memory (1024-MB x 1)

Hard drives Supports 9.5-mm, 6.35-cm (2.50-in) hard drives . .
Customer-accessible . .
Serial ATA . .
Suppors the following drives: . .
e 500-GB, 7200-rpm
e 320-GB, 7200-rpm
e  250-GB, 7200-rpm
HP 3D DriveGuard (not available on Linux) . .

Optical drives Fixed, no modular requirements . .
SATA 12.7-mm tray load . .
Supports option of no optical drive . .
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Category Description HP ProBook HP ProBook

4525s UMA 4525s discrete
Supports the following drives: . .
e  DVD-ROM Drive
e  DVDzRW SuperMulti Double-Layer Combo Drive
with Lightscribe
e  Bluray ROM DVD2RW SuperMulti DL Drive (not
available with UMA base unit and Windows XP)
Diskette drive Supports external USB diskette drive only . .
Audio/visual IDT 92HD80O . .
Integrated microphone . .
Stereo speakers (2) . .
Integrated 2MP camera with fixed focus (select . .
models only)
Modem High-speed 56K modem for all regions and countries ¢ .
except APJ
High-speed 56K modem APJ only . .
Modem cable not included . .
Supports no modem option ° .
Ethernet 10/100/1000 Ethernet network interface card (NIC) .
$3/54/S5 wake on LAN: AC only mode . .
Wireless Integrated WLAN options by way of MiniPCI card:
2 WLAN antennas built into display assembly . .
Supports option for no-WLAN . .
Support for the following WLAN formats: . .

e  Broadcom 802.11b/g/n
e  Broadcom 802.11b/g
e Atheros 802.11 b/g/n (1 x 1)

e  Realtek 802.11 b/g/n (1 x 2)

Integrated personal area network (PAN) options by way of Bluetooth® module:

Support option for no-WPAN . .

Bluetooth 2.1 . .

Integrated WWAN options by way of HP Mobile Broadband Module:

Supports only HP certified WWAN options .

WWAN module UNDP Gobi2 including GPS with 2«
antennas (not available with Linux or Celeron)
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Category

Description

HP ProBook
4525s UMA

HP ProBook
4525s discrete

Dual WWAN antennas (world wide 5 band)

SIM module (user accessible behind battery)

External media cards

One ExpressCard/34-mm

Media Card Reader supporting Memory Stick (MS),

Memory Stick Pro (MSP), Secure Digital (SD) Memory
Card, Secure Digital High Capacity (SDHC) Memory
Card, MultiMediaCard (MMC), and xD-Picture Card

formats

Ports

Audio-in (stereo microphone)

Audio-out (stereo headphone)

RJ-11 (modem)

RJ-45 (Ethernet, includes link and activity lights)

USB 2.0 (3)

Combination eSATA/USB 2.0 (1)

VGA (Dsub 15-pin) supporting 1600 x 1200 external
resolution at 75-GHz (hot plug/unplug with auto-
detect)

Multi-pin AC power

HDMI

Keyboard/pointing
devices

15.6-in keyboard with integrated number pad and
Clickpad

Suports 2-way scroll with legend and gestures (taps
enabled as default)

Power requirements

65-W AC adapter with localized cable plug support
(3-wire plug with ground pin)

90-W AC adapter with localized cable plug support
(3-wire plug with ground pin)

6-cell, 47-Wh Li-ion battery

9-cell, 93-Wh Li-ion battery

Security

Supports Kensington security lock

Fingerprint reader

15.6-in Integrated fingerprint reader

Supports no fingerprint reader option

Operating system

Preinstalled with Microsoft Office:

Windows 7 Home Premium 32 with Office 2007
Ready (excludes Japan)

Windows 7 Home Premium 32 with Office 2007
Personal (Japan only)

Chapter 1 Product description



Category

Description

HP ProBook
4525s UMA

HP ProBook
4525s discrete

Windows 7 Home Premium 32 with Office 2007
Personal with PowerPoint (Japan only)

Windows 7 Home Premium 32 with Office 2007
Professional (Japan only)

Windows 7 Professional with Office 2007 Ready
(excludes Japan)

Windows 7 Professional with Office 2007 Personal
(Japan only)

Windows 7 Professional with Office 2007 Personal
with PowerPoint (Japan only)

Windows 7 Professional with Office 2007
Professional (Japan only)

Windows 7 Professional with Office 2007
Professional with PowerPoint (Japan only)

Windows Vista Home Basic 32 with Office 2007
Ready

Windows Vista Home Basic 32 with Office 2007

Personal (Japan only)

Windows Vista Home Basic 32 with Office 2007

Professional (Japan only)

Windows Vista Business 32 with Office 2007 Ready
(excludes Japan)

Windows Vista Business 32 with Office 2007
Personal (Japan only)

Windows Vista Business 32 with Office 2007
Personal (Japan only)

Windows Vista Business 32 with Office Personal with
PowerPoint (Japan only)

Windows Vista Business 32 with Office Professional
(Japan only)

Windows 7 Starter with Office 2007 ready (excludes
Japan)

Windows 7 Starter 32 with Office 2007 ready —
EDGI

Windows 7 Home Basic 32 with Office 2007 ready
(excludes Japan)

Windows 7 Home Basic with Office 2007 ready -
EDGI

Windows 7 Home Premium with Office 2007 ready —
EDGI
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Category Description

HP ProBook
4525s UMA

HP ProBook
4525s discrete

Windows 7 Professional 32 with Office 2007 ready -
EDGCI

Windows 7 Professional 32 with XP Pro images with
Office 2007 ready (excludes Japan)

Windows 7 Professional 32 with XP Pro images with
Office 2007 ready - EDGI

Windows 7 Professional 32 with XP Pro images with
Office 2007 Personal (Japan only)

Windows 7 Professional 32 with XP Pro images with
Office 2007 Personal with PowerPoint (Japan only)

Preinstalled:

Windows 7 Professional 32 with MS Basics (Japan
only)

Windows 7 Home Premium 32 with MS Basics (Japan
only)

Windows Vista Home Basic 32 with MS Basics (Japan
only)

Windows Vista Business 32 with MS Basics (Japan
only)

Windows 7 Professional 32 (with XP Professional
images) with MS Basics (Japan only)

FreeDOS

RedFlag Linux (People's Republic of China only)

SuSE Linux

Restore media:

Windows 7 Starter

Windows 7 Home Basic 32

Windows 7 Home Premium 32

Windows 7 Professional 32

Windows 7 Professional 64

DRDVD Windows 7 — Home Premium/Pro

DRDVD Windows 7 — Starter/Home Basic

Windows Vista Home Basic 32

Windows Vista Home Premium

Windows Vista Business 32

Windows XP Professional

Chapter 1
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Category

Description

HP ProBook
4525s UMA

HP ProBook
4525s discrete

SuSE Linux

Red Flag Linux (People's Republic of China only)

DRDVD Windows Vista

DRDVD Windows XP Pro

Certified: Microsoft® WHQL

Web-only Support:

Windows 7 Professional 64 versions

Serviceability

End-user replaceable parts:

AC adapter

Battery (system)

Hard drive

Memory module

Optical drive

WILAN module

WWAN module




2 External component identification

B NOTE: Depending on the operating system installed on your comouter, some components may
function differently than described. Some functionality may not be supported by the operating system
installed on your computer.

Top Components
TouchPad

3 4
Component Description
(1 TouchPad off indicator light To turn the TouchPad zone on and off, quickly doubletap the
TouchPad off indicator.
NOTE: When the TouchPad zone is active, the light is off.
(2) TouchPad zone* Moves the pointer and selects or activates items on the screen.
(3) Left TouchPad button Functions like the left button on an external mouse.

Chapter 2 External component identification



Component

Description

(4) Right TouchPad button

Functions like the right button on an external mouse.

*This table describes factory seftings.

Top Components
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Lights

B NOTE: Your computer may look slightly different from the illustration in this section.

@@ © ©

Component Description

1) TouchPad off indicator e Amber: The TouchPad is off.

o  Off: The TouchPad is on.

(2) Caps lock light On: Caps lock is on.

(3) HP QuickLook light Blinking: QuickLook is being opened or closed.

(4) HP QuickWeb light Blinking: QuickWeb browser is being opened or closed.
(5) Power light e  On: The computer is on.

e  Blinking: The computer is in the Sleep state.

e  Off: The computer is off or in Hibernation.

(5) Wireless light e White: An infegrated wireless device, such as a wireless
local area network (WLAN) device and/or a Bluetooth®
device, is on.

o Amber: All wireless devices are off.

10 Chapter 2 External component identification



Buttons, switches, and speakers (select models only)

B NOTE: Your computer may look slightly different from the illustration in this section.

Component

Description

(1) Speakers (2)

Produce sound.

(2) Internal display switch

Turns off the display if the display is closed while the power is on.

(3) Power button

e  When the computer is off, press the button to turn on the
computer.

e When the computer is on, press the button to shut down the
computer.

e When the computer is in the Sleep state, press the button
briefly to exit Sleep.

e When the computer is in Hibernation, press the button briefly
to exit Hibernation.

If the computer has stopped responding and Windows shutdown
procedures are ineffective, press and hold the power button for at
least 5 seconds to turn off the computer.

(4) Fingerprint reader (select models only)

Allows a fingerprint logon to Windows, instead of a password
logon.

Top Components
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Component Description

(1) esc key Displays system information when pressed in combination with the
fn key.

(2) fn key Executes frequently used system functions when pressed in
combination with a function key, the num lk key, or the esc key.

(3) Windows logo key Displays the Windows Start menu.

(4) Windows applications key Displays a shortcut menu for items beneath the pointer.

(5) Integrated numeric keypad keys Can be used like the keys on an external numeric keypad.

(6) Function keys Execute frequently used system functions when pressed in

combination with the fn key.

Chapter 2 External component identification



Front components

e
® OO

Component

Description

(1) Drive light

e Blinking white: The hard drive or optical drive is being
accessed.

e  Amber: HP 3D DriveGuard has temporarily parked the hard
drive.

(2) Media Card Reader

Supporis the following optional digital card formats:
e Memory Stick

e  Memory Stick Duo (adapter required)

e  Memory Stick Pro (adapter required)

e  MultiMediaCard (MMC)

e  Secure Digital (SD) Memory Card

e  xD-Picture Card (XD)

e  xD-Picture Card (XD) Type H

e  xD-Picture Card (XD) Type M

(3) Audio-out (headphone) jack

Produces sound when connected to optional powered stereo
speakers, headphones, ear buds, a headset, or television audio.

NOTE: When a device is connected to the headphone jack, the
computer speakers are disabled.

(4) Audio-in (microphone) jack

Connects an optional computer headset microphone, stereo array
microphone, or monaural microphone.

Right-side components

Front components
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Component Description

(1) USB ports (2) Connect optional USB devices.

(2) RJ-11 (modem) jack (select models only) Connects a modem cable.

(3) Optical drive (select models only) Reads optical discs and, on select models, also writes to optical
discs.

(4) Optical drive light (select models only) Blinking: The optical drive is being accessed.

(5) AC adapter light e  On: The computer is connected to external power and the

battery is charging.

e  Off: The computer is not connected to external power.

(6) Power connector Connects an AC adapter.

Chapter 2 External component identification



Left-side components

Component

Description

m

Security cable slot

Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a deterrent, but it
may not prevent the computer from being mishandled or stolen.

(2)

Vent

Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool internal
components and prevent overheating. It is normal for the internal
fan to cycle on and off during routine operation.

(3)

External monitor port

Connects an external VGA monitor or projector.

(4

RJ-45 (network) jack

Connects a network cable.

(5)

HDMI port

Connects an optional HDMI device.

(6)

Combo eSATA/USB port

Connects an optional USB device or high-performance eSATA
components such as an eSATA external hard drive.

)

USB port

Connects optional USB device.

(®)

ExpressCard slot

Supports optional ExpressCards.

Left-side components
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Bottom components

® (g)
N —

Component Description

(1) Battery release latches (2) Release the battery from the battery bay.

(2) Battery bay Holds the battery.

(3) SIM slot (select models only) Contains a wireless subscriber identity module (SIM). The SIM slot

is located inside the battery bay.

Display

EX NOTE: Your computer may look slightly different from the illustration in this section.
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Component Description

(1) Internal display switch Turns off the display if the display is closed while the power is on.
(2) Internal microphone Records sound.

(3) Webcam light (select models only) On: The webcam is in use.

(4) Webcam (select models only) Records audio and video and captures still photographs.

Display

17



Wireless antennas

The antennas send and receive signals from one or more wireless devices. These antennas are not
visible from the outside of the computer.

Component Description

(1) WWAN antennas (2)* (select models only) Send and receive wireless signals to communicate with wireless
wide-area networks (WWAN).

(2) WILAN antennas (2)* Send and receive wireless signals to communicate with wireless
local area networks (WLAN).

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions.

To see wireless regulatory notices, refer to the section of Regulatory, Safety and Environmental Notices
that apply to your country or region. These notices are located in Help and Support.

18 Chapter 2 External component identification



Additional hardware components
07

Component Description
(1) Power cord* Connects an AC adapter to an AC outlet.
(2) Battery* Powers the computer when the computer is not plugged info

external power.

(3) AC adapter Converts AC power to DC power.

*Batteries and power cords vary in appearance by country or region.

Additional hardware components 19



3 lllustrated parts catalog

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag.

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

(3) Part number/product number (p/n): This number provides specific information about the product's
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for your computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

- product @ X00000000XEXX000
- sfm : aooooccoooss  NHIININEANEENEGITTINNE
L e koo I A IR0 R A0

SEIVICE | X0o0e
tag | warranty X year

i)

00
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Computer major components

Item  Description

(1) Display assembly (includes microphone, 2 WLAN antenna transceivers and cables and, on select computer
models, 2 WWAN antenna transceivers and cables)

Computer major components 21
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Item  Description
e 15.6-in HD BrightView display assembly for use in computers equipped with webcam 613219-001
and WWAN (1366x768 resolution)
e 15.6-in HD BrightView display assembly for use in computers with webcam (1366x768  613218-001
resolution)
e 15.6-in HD BrightView display assembly (1366x768 resolution) 613215-001
e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 613217001
and WWAN (1366x768 resolution)
e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 613216-001
(1366x768 resolution)
e 15.6-in HD AntiGlare display assembly (1366x768 resolution) 613214001
e 15.4-in HD BrightView display assembly for use in computers with webcam, WWAN, 613230-001
and red trim (1366x768 resolution)
e  15.4-in HD BrightView display assembly for use in computers with webcam and red trim  613229-001
(1366x768 resolution)
e 15.6-in HD BrightView display assembly for use in computers with red trim (1366x768  613226-001
resolution)
e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam, 613228-001
WWAN, and red trim (1366x768 resolution)
e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 613227-001
and red trim (1366x768 resolution)
e 15.6-in HD AntiGlare display assembly for units with red trim (1366x768 resolution) 613225-001
(2) Switch cover 598674-001
e  For use in computers with red trim 604853-001
(3) Keyboard 615600-xxx
NOTE: For a detailed list of available keyboards, see Sequential part number listing
on page 33.
(4) Palm rest (includes TouchPad and cables) 615601-001
For use in computers with red trim 615603-001
For use in computers with fingerprint reader 615602-001
For use in computers with fingerprint reader and with red trim 615604-001
(5) Thermal shield with gasket 617451-001
(6) Power button board 609952001
(7) ExpressCard bezel (part of Plastics Kit spare part number 613223-001)
(8) Speakers 598685-001
(9) Top cover 615797-001
(10) Audio board 598684-001
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Item

Description

an

Bluetooth module

HP Integrated module with Bluetooth 2.1 wireless technology For use in
Andorra, Argentina, Australia, Austria, Bangladesh, Belarus, Belgium, Bermuda, Brazil,
Brunei, Bulgaria, Canada, Cayman Islands, Chile, China, Croatia, Cyprus, Czech Republic,
Denmark, Egypt, El Salvador, Estonia, Finland, France, Germany, Greece, French Guiana,
Guadeloupe, Guam, Hong Kong, Hungary, Iceland, India, Indonesia, Ireland, Israel, ltaly,
Japan, Jordan, South Koreaq, Latvia, Puerto Rico, Liechtenstein, Lithuania, Luxembourg,
Malaysia, Malta, Martinique, Mexico, Morocco, Netherlands, New Zealand, Norway,
Pakistan, Panama, Peru, Philippines, Poland, Portugal, Romania, Russia, Saudi Arabia,
Singapore, Slovakia, Slovenia, South Africa, Spain, Sri Lanka, Sweden, Switzerland, Taiwan,
Thailand, Tunisia, Turkey, Ukraine, United Arab Emirates, the United Kingdom, the United
States, Venezuela, Virgin Islands

537921-001

(12)

Fan/heat sink assembly

For use in computers with discrete graphics subsystems

613291-001

For use in computers with UMA graphics subsystems

598676-001

(13)

System board (includes RTC battery and replacement thermal material)

System board with discrete graphics subsystem memory

613212-001

System board with UMA graphics subsystem memory

613211-001

System board with UMA graphics subsystem memory and WWAN

613213-001

System board with UMA graphics subsystem memory (for use only in Russia and the People's
Republic of China)

613286-001

System board with discrete graphics subsystem memory (for use only in Russia and the
People's Republic of China)

613287-001

System board with UMA graphics subsystem memory and WWAN (for use only in Russia and
the People's Republic of China)

613288-001

(14)

Power connector (part of Base Cable Kit 613224-001)

(15)

RJ-11 connector (part of Base Cable Kit 613224-001)

(16)

USB connector (part of Base Cable Kit 613224-001 for computers)

17)

WLAN module

Broadcom 4312G 802.11b/g WiFi adapters:

Computer major components
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Item

Description

For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda,
Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia,
Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria,
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad,
Chile, the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica,
Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican
Republic, East Timor, Ecuador, Egypt, El Salvador, Equitorial Guineaq, Eritrea, Estonia,
Ethiopia, Fiji, Finland, France, French Guiana, Gabon, Gambia, Georgia, Germany,
Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, Guinea, Guinea-Bissau,
Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, Israel, ltaly, the
Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia,
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolig,
Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the
Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan,
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal,
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome
and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore,
Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname,
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad
and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab
Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam,
Yemen, Zaire, Zambia, and Zimbabwe

504593-004

Atheros 9285G 802.11b/g/n WiFi Adapter for use in all countries and regions

605560-005

Realtek RTL8191SE 802.11b/g/n WiFi Adapter for use in all countries and regions

593533-001

(18)

AMD Processor (includes replacement thermal material) (not illustrated)

Athlon 1l P320, 2.1-GHz, 1-MB L2 cache Dual-Core (25W)

594165-001

V-Series V120, 2.2-GHz, 512K L2 cache Single-Core (25W)

594171-001

Turion Il P520, 2.3-GHz, 2-MB L2 cache Dual-Core (25W)

594173-001

Phenom Il P820, 1.8-GHz, 1.5-MB L2 cache, Tri-Core (25W)

594167-001

Phenom Il P920, 1.6-GHz, 2-MB L2 cache Quad-Core (25W)

594170-001

(19)

RTC battery

616073-001

(20)

HP un2420 Broadband Module (WWAN)

531993-010

(21)

ODD extender

598687-001

(22)

Modem module

NOTE: The modem module spare part kit does not include a modem module cable. The
modem module cable is included in the Base Cable Kit, spare part numbers 613224-001.
See Cable Kits on page 28 for more Cable Kit spare part information.

For use in all countries and regions except Australia and New Zealand

510100-001

For use only in Australia and New Zealand

510100-011

(23)

Memory module
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Item  Description
2-GB (PC3-10600, 1333-MHz, DDR3) 598856-001
1-GB (PC3-10600, 1333-MHz, DDR3) 598859-001
(24) Battery
9-cell, 93-Wh, 2.8-Ah 593573-001
6-cell, 47-Wh, 2.2 Ah 593572-001
(25) Base enclosure 618248-001
(26) Hard drive (includes hard drive bracket)
500-GB, 7200-rpm 616288-001
320-GB, 7200-rpm 616287-001
250-GB, 7200-rpm 616286-001
(27)  Optical drive (includes bezel)
DVD-ROM drive 616795-001
DVD+RW Double-Layer Drive with LightScribe 616796001
Blu-ray DVD+R/RW Double-Layer 616797-001
Rubber Kit (not illustrated, contains: 10 front rubber feet, 10 rear rubber feet, 10 back 598678-001

edge screw covers, and 10 mylar screw covers for LCD bezel)

Computer major components
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Display assembly components

o_

ltem Description Spare part number
(1 Display bezel
For use in computers without webcam 615596-001
For use in computers with webcam 615597001
(2) Webcam module 598671001
(3) Display (For Reference only. Not spared separately.)
(4) Display Hinge Kit 598679-001
(5) Microphone cable
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Item Description Spare part number
(6) LCD Cable Kit with webcam cable 600925-001
LCD Cable Kit without webcam cable 600972-001
(7) WILAN and WWAN antenna transceivers and cables
(8) Display enclosure
For use in computers with 15.6-in displays without WWAN 600928-001
For use in computers with 15.6-in displays and WWAN 615598-001
For use in computers with 15.6-in displays and red trim 615612001

Plastics Kit

0—\

B_

Item Description Spare part number
Plastics Kit: 598673-001

(1) ExpressCard slot bezel

(2) Optical drive bezel

(3) RJ-11 door
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Cable Kits

Item Description Spare part number

Base Cable Kit , includes DC-in cable (1), USB cable (2), Bluetooth cable (3), and 613224-001
RJ-11 cable (4).

(1) DCin cable

(2) USB cable

(3) Bluetooth cable

(4) RIT1 cable
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ltem Description Spare part number
Misc LCD Cable Kit, includes microphone cable (1), WWAN transceiver with cable (2), 615599-001
and WLAN transceiver with cable (3)

(1) Microphone cable

(2) WWAN transceiver with cable

(3) WLAN transceiver with cable

Item Description Spare part number
(1) LCD Cable Kit with webcam cable and WWAN 615805-001
LCD Cable Kit without webcam cable and WWAN 615806-001
LCD Cable Kit without webcam 600972001
Cable Kits
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Mass storage devices

o—

Item Description Spare part number

(1) Hard drive (includes bracket)

750-GB, 5400-rpm 616289-001
500-GB, 7200-rpm 616288-001
320-GB, 7200-rpm 616287-001
250-GB, 7200-rpm 616286-001

(2) Optical drive (includes bezel)

DVD+RW Double-Layer Drive with LightScribe 616796001

Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer 616797001
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Miscellaneous parts

Description Spare part number

AC adapters

65-W AC adapter for use in computers with UMA graphics 609939-001

90-W Slimline PFC AC adapter for use in computers with discrete graphics 609940-001

Power cords

For use in Argentina 490371-DO1
For use in Australia and New Zealand 490371-011
For use in Brazil 490371-201
For use in Denmark 490371081
For use in Europe, the Middle East, and Africa 490371-021
For use in India 490371-D61
For use in Israel 490371-BB1
For use in ltaly 490371061
For use in Japan 490371-291
For use in the People's Republic of China 490371-AA1
For use in South Africa 490731-AR1
For use in South Korea 490371-AD1
For use in Switzerland 490371-111
For use in Taiwan 490371-AB1
For use in the United Kingdom 490371-031
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Description Spare part number

For use in the United States 490371-001

Screw Kit, includes: 598672-001
e (5) Phillips 2.0x2.0 screws

e  (5) Phillips 2.0x2.5 broadhead screws

e (5) Phillips 2.0x2.5 screws

e (5) Phillips 2x7.0 screws

e  (5) Phillips 2.5%3.0 screws

e (5) Phillips 2.5%5.0 screws

e (5) Torx 2.5%5.0 screws

o (5) Torx 2.5%6.0 screws

e (5) Phillips 2.5%8.0 screws

e  (10) Phillips 3.0x4.0 screws
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Sequential part number listing

Spare part  Description

number

490371-001 Power cord for use in the United States

490371-011 Power cord for use in Australia and New Zealand

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061  Power cord for use in ltaly

490371-081 Power cord for use in Denmark

490371-111 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1  Power cord for use in the People's Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1  Power cord for use in South Korea

490371-BB1 Power cord for use in Israel

490371-D01  Power cord for use in Argentina

490371-D61  Power cord for use in India

504593004  Broadcom 4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, Angola,
Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain,
Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina,
Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde,
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, Comoros, the Congo,
Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East
Timor, Ecuador, Egypt, El Salvador, Equitorial Guineaq, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland,
Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia,
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi,
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico,
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether
Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau,
Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova,
Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the
Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South
Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland,
Sweden, Switzerland, Taiwan, Taijikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey,
Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay,
Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

510100-001  Modem module for use in all countries and regions except Australia and New Zealand

510100-011 Modem module for use in Australia and New Zealand

531993-010  HP un2420 Broadband Module
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Spare part  Description
number

537921-001  Bluetooth module with Bluetooth 2.1 wireless technology

593533-001  Realtek RTL8T191SE 802.11b/g/n WiFi Adapter

593572001  Battery, 6-cell, 47 Wh, 2.2 Ah for use in computers with 15.6-in displays

593573-001  Battery, 9-cell, 93 Wh, 2.8 Ah for use in computers with 15.6-in displays

594165-001  Athlon Il P320, 2.1-GHz, 1-MB L2 cache Dual-Core (25W)

594167-001  Phenom Il P820, 1.8-GHz, 1.5-MB L2 cache, Tri-Core (25W)

594170-001  Phenom Il P920, 1.6-GHz, 2-MB L2 cache Quad-Core (25W)

594171-001  V-Series V120, 2.2-GHz, 512K L2 cache Single-Core (25W)

594173-001  Turion Il P520, 2.3-GHz, 2-MB L2 cache Dual-Core (25W)

598671-001  Webcam module

598673-001 Plastics Kit

598674-001  Switch cover with power button switch for use in computers with 15.6-in displays

598676-001  Fan/heat sink assembly for computers with UMA graphics

598678-001  Rubber Kit

598679-001  Display Hinge Kit for use in computers with 15.6-in display

598684-001  Audio board

598685-001  Speaker Kit for use in computers with 15.6-in displays

598688-001  Palm rest for use in computers with 15.6-in displays with cable but without fingerprint reader

598690-001  Display bezel for use in computers with 15.6-in displays without webcam

598856-001  Memory module, 2-GB (PC3-10600, 1333-MHz, DDR3)

598859-001  Memory module, 1-GB (PC3-10600, 1333-MHz, DDR3)

598867-001  System board with UMA graphics subsystem memory

598868-001  System board with discrete graphics subsystem memory

598869-001  System board with UMA graphics subsystem memory and WWAN

599804-001  Palm rest for use in computers with 15.6-in displays with TouchPad, fingerprint reader, and cables

599806-001  Misc LCD Cable Kit, includes microphone, WLAN, and WWAN cables for computers with 15.6-in displays

598856-001 Memory module, 2-GB (PC3-10600, 1333-MHz, DDR3)

598859-001  Memory module, 1-GB (PC3-10600, 1333-MHz, DDR3)

600925-001  LCD Cable Kit with webcam cable

600927-001 LCD cable without webcam cable

605660-005  Atheros 9285G 802.11b/g/n WiFi Adapter

607133-001  Display enclosure for use in computers with 15.6-in displays and red trim
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Spare part  Description

number

609939-001  65W Power adapter

609940-001  90-W Slimline PFC AC adapter for use in computers with discrete graphics

609952-001  Power board button

613211001  System board for computers with UMA graphics

613212001  System board for computers with discrete graphics

613213001  System board for computers with UMA graphics and WWAnR

613214001  15.6-in HD AntiGlare display assembly (1366x768 resolution)

613215001  15.6-in HD BrightView display assembly (1366x768 resolution)

613216001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam (1366x768 resolution)

613217-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and WWAN
(1366x768 resolution)

613218001  15.6-in HD BrightView display assembly for use in computers with webcam (1366x768 resolution)

613219001 15.6-in HD BrightView display assembly for use in computers equipped with webcam and WWAN
(1366x768 resolution)

613224-001 Base Cable Kit for use in computers with 15.6-in displays, includes: RJ-11 cable, modem cable, Bluetooth
cable, and DC-in cable

613225001  15.6-in HD AntiGlare display assembly for units with red trim (1366x768 resolution)

613226-001 15.6-in HD BrightView display assembly for use in computers with red trim (1366x768 resolution)

613227-001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and red trim
(1366x768 resolution)

613228001  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam, WWAN, and red trim
(1366x768 resolution)

613229001  15.6-in HD BrightView display assembly for use in computers with webcam and red trim (1366x768
resolution)

613230-001  15.6-in HD BrightView display assembly for use in computers with webcam, WWAN, and red trim
(1366x768 resolution)

613286001  System board with UMA graphics subsystem memory (for use only in Russia and the People's Republic of
China)

613287-001  System board with discrete graphics subsystem memory (for use only in Russia and the People's Republic of
China)

613288-001  System board with UMA graphics subsystem memory and WWAN (for use only in Russia and the People's
Republic of China)

613289001  LCD Cable without webcam cable

613291001  Fan/heat sink assembly for use in computers with discrete graphics subsystems

613292-001  Heat sink for system board

615596-001  Display bezel for use in computers without webcam
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Spare part  Description

number

615597-001  Display bezel for use in computers with webcam

615598-001  Display enclosure

615599001  Misc LCD Cable Kit

615600-001  Keyboard for use in the United States on computers with 15.6-in displays
615600-031  Keyboard for use in the United Kingdom on computers with 15.6-in displays
615600041  Keyboard for use in Germany on computers with 15.6-in displays
615600051  Keyboard for use in France on computers with 15.6-in displays
615600-061  Keyboard for use in ltaly on computers with 15.6-in displays
615600-071  Keyboard for use in Spain on computers with 15.6-in displays
615600081  Keyboard for use in Denmarkon computers with 15.6-in displays
615600091  Keyboard for use in Norway on computers with 15.6-in displays
615600-131  Keyboard for use in Portugal on computers with 15.6-in displays
615600-141  Keyboard for use in Turkey on computers with 15.6-in displays
615600-171  Keyboard for use in Saudi Arabia on computers with 15.6-in displays
615600-211  Keyboard for use in Hungary on computers with 15.6-in displays
615600-221  Keyboard for use in the Czech Republic on computers with 15.6-in displays
615600-231  Keyboard for use in Slovakia on computers with 15.6-in displays
615600-251  Keyboard for use in Russian computers with 15.6-in displays
615600-261  Keyboard for use in Bulgaria on computers with 15.6-in displays
615600-281  Keyboard for use in Thailand on computers with 15.6-in displays
615600-291  Keyboard for use in Japan on computers with 15.6-in displays
615600-A41  Keyboard for use in Europe on computers with 15.6-in displays
615600-A81  Keyboard for use in the Czech Republic on computers with 15.6-in displays
615600-AB1  Keyboard for use in Taiwan on computers with 15.6-in displays
615600-AD1  Keyboard for use in South Korea on computers with 15.6-in displays
615600831  Keyboard for International use on computers with 15.6-in displays
615600871  Keyboard for use in Finland on computers with 15.6-in displays
598691-BA1  Keyboard for use in Slovenia on computers with 15.6-in displays
615600-BB1  Keyboard for use in Israel on computers with 15.6-in displays
615600BG1  Keyboard for use in Switzerland on computers with 15.6-in displays
615600-DD1  Keyboard for use in Iceland on computers with 15.6-in displays
615600-D)1 Keyboard for use in Greece on computers with 15.6-in displays
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Spare part  Description

number

615600-DW1  Keyboard for use in French Arabic region on computers with 15.6-in displays
615601-001  Palm rest

615602-001  Palm rest for use in computers with fingerprint reader

615603-001  Palm rest for use in computers with red trim

615604-001  Palm rest for use in computers with fingerprint reader and red trim
615612-001  Display enclosure for use in computers with 15.6-in displays and red trim
615797-001  Top cover

615805001  LCD Cable Kit with web cam

615806-001 LCD Cable Kit without web cam

616073-001 RTC battery

616286-001  250-GB, 7200 rpm hard drive (includes hard drive bracket)
616287001  320-GB, 7200 rpm hard drive (includes hard drive bracket)
616288001  500-GB, 7200 rpm hard drive (includes hard drive bracket)
616795-001 DVD—ROM drive

616796001  DVD+RW Double-Layer Drive with LightScribe

616797-001  Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer
617451-001  Thermal shield with gasket

618248001  Base enclosure

Sequential part number listing
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required
You will need the following tools to complete the removal and replacement procedures:
e  Flatbladed screwdriver
e Magnetic screwdriver
e  Phillips PO and P1 screwdrivers

e Torx T8 screwdriver

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

B NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

A CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the maintenance
instructions.
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Cables and connectors

A CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.

Drive handling

A CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage fo a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the operating
system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers.
Avoid exposing a drive o temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”
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Grounding guidelines

Electrostatic discharge damage

40

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.

CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.
Use nonmagnetic tools.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by different
activities.

A CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

Relative humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V 5,000 V 3,000 V
Motions of bench worker 6,000V 800V 400 V
Removing DIPS from plastic tube 2,000 V 700V 400 V
Removing DIPS from vinyl tray 11,500 V 4,000V 2,000 V
Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V
Removing bubble pack from PCB 26,500V 20,000 V 7,000V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines
Follow these grounding guidelines when packaging and transporting equipment:
e To avoid hand contact, transport products in staticsafe tubes, bags, or boxes.
e  Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.
e Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.
e  Place items on a grounded surface before removing items from their containers.
e  Always be properly grounded when touching a component or assembly.

e  Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive
foam.

e  Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines
Follow these grounding workstation guidelines:
e  Cover the workstation with approved static-shielding material.

e Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

e  Use conductive field service tools, such as cutters, screwdrivers, and vacuums.

e  When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe
materials.

e Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and
Styrofoam.

e Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at staticfree workstations.

e  Avoid contact with pins, leads, or circuitry.

e  Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines
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Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm +10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive strips must
be worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

Antistatic tape

Antistatic smocks, aprons, and sleeve protectors

Conductive bins and other assembly or soldering aids
Nonconductive foam

Conductive tabletop workstations with ground cords of one megohm resistance
Static-dissipative tables or floor mats with hard ties to the ground
Field service kits

Static awareness labels

Material-handling packages

Nonconductive plastic bags, tubes, or boxes

Metal tote boxes

Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level
Antistatic plastic Bags 1,500 V
Carbon-loaded plastic Floor mats 7,500 V
Metallized laminate Floor mats 5,000 V
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Component replacement procedures

This section provides removal and replacement procedures.

There are many screws, in many different sizes, that must be removed, replaced, or loosened when
servicing the computer. Make special note of each screw size and location during removal and
replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model
description provided on the service tag:

(1) Product name: This is the product name affixed to the front of the computer.
(2) Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

art number/product number (p/n): This number provides specific information about the product's
3) Part number/product number (p/n): Thi ber provides specific information about the product'
hardware components. The part number helps a service technician to determine what components and
parts are needed.

(4) Model description: This is the alphanumeric identifier used to locate documents, drivers, and
support for the computer.

(5) Warranty period: This number describes the duration of the warranty period for this computer.

- product @ X000000000 K00
- sfn ooooococooss  IHTIRIIREAEENENINNEII
L pfn e xxasocc 1AM 00 D

service | xmoooo
tag | warranty X year

i)

00
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part
number 598678-001. There are 4 rubber feet that attach to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number
6-cell, 47-Wh, 2.2-Ah Li-on battery for use in computers with 15.6-in displays 593572001
9-cell, 93-Wh, 2.8-Ah Li-on battery for use in computers with 15.6-in displays 593573-001

Before disassembling the computer, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery:
1. Turn the computer upside-down on a flat surface with the battery bay toward you.
2. Slide the battery release latches (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click.
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Switch cover and keyboard

Description Spare part number

Switch cover with power button board

For use in computers with 15.6-in displays 598674001
For use in computers with 15.6-in displays with red trim 604853-001
Keyboard

Keyboards for use in computers with 15.6-in displays 59869 1-xx1

NOTE: For a detailed list of available keyboards, see Sequential part number listing on page 33.

Before removing the switch cover and keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard:

1. Position the computer upside-down with the rear toward you.
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2. To remove the switch cover, remove the following:
(1) Two mylar screw covers on the rear edge of the computer
(2) Two PM2.5%2.5 screws
(3) Three PM2.0x2.5 broadhead screws located in the battery bay

3. Open the computer as far as possible.

4. Slide the switch cover back (1), and then remove it from the computer (2).
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5. Remove the two Phillips PM2.5x5.0screws that secure the keyboard to the computer.

6. Slide the keyboard back toward the display (1), and then rotate it forward (2) until it rests upside-
down on the palm rest.
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7.

8.

It
°

Release the zero insertion force (ZIF) connector (1) to which the keyboard cable is attached, and
disconnect the keyboard cable (2) from the system board.

Ef NOTE: Only disconnect the keyboard cable from the system board when replacing the
keyboard or removing the top cover. It is not recommended that you disconnect the cable unless it
is absolutely necessary.

Remove the keyboard.

is not necessary to disconnect the keyboard for any of the components listed here:
memory module

optical drive

speakers

thermal shield

WILAN

WWAN

fan/heat sink

palm rest

hard drive

Reverse this procedure to install the switch cover and keyboard.
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Memory module

B NOTE: When adding a second memory module, be sure it is the same type and speed as the
installed memory module.

Description Spare part number
2-GB (PC3-10600, 1333-MHz, DDR3) 598701-001
1-GB (PC3-10600, 1333-MHz, DDR3 598700-001

Before removing the memory module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

B NOTE: It is not necessary to disconnect the keyboard cable from the system board to remove the
memory modules.

Remove the memory module:
1. Position the computer right-side up with the front toward you.

2. Spread the retaining tabs (1) on each side of the memory module slot to release the memory
module. (The edge of the module opposite the slot rises away from the computer.)
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3. Remove the memory module (2) by pulling the module away from the slot at an angle.

Ef NOTE: Memory modules are designed with a notch to prevent incorrect insertion into the
memory module slot.

Reverse this procedure to install a memory module.

Optical drive

B NOTE: All optical drive spare part kits include an optical drive bezel.

Description Spare part number
DVD=RW Double-Layer Drive with LightScribe (includes bezel) 616796-001
Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer (includes bezel) 696797001
DVD-ROM Drive (includes bezel) 616795-001

Before removing the optical drive, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

B NOTE: It is not necessary to disconnect the keyboard cable from the system board to remove the
optical drive.

Remove the optical drive:
1. Position the computer with the right side toward you.
2. Remove the Phillips PM2.5x5.0 screw (1) that secures the optical drive to the computer.

3. Insert a flat-bladed screwdriver or similar tool into the optical drive tab access (2) and press the
tab to the right fo release the optical drive from the computer.

4. Remove the optical drive (3) from the computer.

B NOTE: 15.6-in model shown below

5. |Ifitis necessary fo replace the optical drive bracket, position the optical drive with the rear toward
you.

6. Remove the two Phillips PM2.0x2.0 screws (1) that secure the optical drive bracket to the optical
drive.
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7. Remove the optical drive bracket (2).

a";::i%#
o %

Reverse this procedure to reassemble and install an optical drive.

Power button board

Description Spare part number

Switch cover with power button board

For use in computers with 15.6-in displays 598674-001

Before removing the power button board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).
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Remove the power button board.

1. Release the ZIF connector (1) and disconnect the ribbon cable (2) from the system board.

2. Remove the screw (1) that secures the power button board to the base pan and the slide the
board out of the retainer (2) to the left (3) to remove it.

Reverse this procedure to install the power button board.
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Speakers

Description Spare part number

For use in computers with 15.6-in displays 598685-001

Before removing the speakers, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Disconnect the power button cable from the system board (see Power button board on page 53).
Remove the speakers from the 15.6-in computer:

1. Remove the two PM2.5x6.0 screws (1) that secure the speakers to the top cover.

2. Disconnect the speaker cable connector (2) from the system board.

3. Remove the cables from the routing channels and the speakers (3) from the computer.
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Reverse this procedure to install the speakers.

Thermal shield
B NOTE: The spare part number for the thermal shield is 617451-001.

56

Before removing the thermal shield, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

NOTE: It is not necessary to disconnect the keyboard cable from the system board before
removing the thermal shield.

Remove the thermal shield on the 15.6-in computer:

1.
2.
3.

Position the computer rightside up with the front toward you.
Remove the two PM2.5x3.0 screws (1 and 2) from the thermal shield.

Raise the thermal shield (3) and remove it (4) from the computer.
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Reverse this procedure to reassemble and install an optical drive.
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WLAN module

Description Spare part number

Broadcom 4312 802.11b/g WLAN modules

e  For use in Afghanistan, Albania, Algeria, Andorra, Angola, Antigua and Barbuda, Argentina,  504593-004
Armenia, Aruba, Australia, Austria, Azerbaijan, the Bahamas, Bahrain, Bangladesh,
Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, Bolivia, Bosnia and
Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, Burkina Faso,
Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the People's
Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech
Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt,
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana,
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe,
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland,
Indiq, Ireland, Israel, ltaly, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati,
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg,
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands,
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro,
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New
Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New
Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, the Republic of Moldova, Romania,
Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, Saudi Arabia, Senegal,
Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the Solomon Islands,
Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent
and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, Tajikistan,
Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda,
Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu,
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

Atheros 9285G 802.11 b/g/n WiFi Adapter for use in all countries and regions 605560-005

Realtek RTLBAISE 802.11b/g/n WiFi Adapter for use in all countries and regions 593533001

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module fo restore computer functionality, and then contact technical support through Help and Support.

Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 46)

b. Thermal shield (see Thermal shield on page 56)
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Remove the WLAN module:
1. Position the computer rightside up with the front toward you.

2. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

B NOTE: The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The
white WLAN antenna cable is connected to the WLAN module “Aux” terminal.

3. Remove the two Phillips PM2.0x4.0 screws (2) that secure the WLAN module to the computer.
(The edge of the module opposite the slot rises away from the computer.)

4. Remove the WLAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WLAN modules are designed with a notch (4) to prevent incorrect insertion.

Reverse this procedure to install the WLAN module.

WWAN module
B NOTE: Only computers with UMA graphics include a WWAN module.

NOTE: The spare part number for the HP un2420 Broadband Module is 531993-010.

A CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore computer functionality, and then contact technical support through Help and Support.
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Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Remove the WWAN module:
1. Position the computer rightside up with the front toward you.

2. Remove the protective gasket that is adhered to the top of the WWAN module.

3. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

B’ NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal. The
terminals and cables are both identified by number and color.

4. Remove the two Torx M2.5x6.0 screws (2) that secure the WWAN module to the computer. (The
edge of the module opposite the slot rises away from the computer.)
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5. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

B NOTE: WWAN modules are designed with a notch (4) to prevent incorrect insertion.
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Reverse this procedure to install the WWAN module.

Heat sink and fan

B NOTE: The heat sink spare part kit includes replacement thermal material.

Description Spare part number
Heat sink for use in computers with UMA graphics subsystems 598676-001
Heat sink for use in computers with discrete graphics subsystems 613291001

Before removing the heat sink, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.
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4. Remove the battery (see Battery on page 45).

5. Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 46).

B’ NOTE: It is not necessary to disconnect the keyboard to remove or install the heat sink.

b. Thermal shield (see Thermal shield on page 56).

Remove the heat sink:
e  For computers with discrete subsystem memory on the system board, follow these steps:
1. Position the computer rightside up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the six captive screws (1), (2), (3),
(4), (5), (6), around the processor.

3. Disconnect the fan cable from the system board (7), and then remove the heat sink (8).
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4. Clean the thermal material from the surfaces of the heat sink components (1), (3), and (5) and
from the system board (2), (4), and (6) when the heat sink is removed. Replacement thermal
material is included with all heat sink, system board, and processor spare part kits.

e  For computers with UMA subsystem memory on the system board, follow these steps:
1. Position the computer rightside up with the front toward you.

2. Following the sequence stamped into the heat sink, loosen the six screws (1), (2), (3), (4), (5),
and (6) around the processor.

Component replacement procedures 63



3. Disconnect the fan cable from the system board (7), and remove the heat sink (8).
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4. Clean the thermal material from the surfaces of the heat sink components (1), (3), and (5) and the
system board (2), (4), and (6) each time the heat sink is removed. Replacement thermal material
is included with all heat sink, system board, and processor spare part kits.

Reverse this procedure to install the heat sink and fan.

Processor

B NOTE: The processor spare part kit includes replacement thermal material.

Description Spare part number
Athlon 11 P320, 2.1-GHz, 1-MB L2 cache Dual-Core (25W) 594165-001
V-Series V120, 2.2-GHz, 512K L2 cache Single-Core (25W) 594171-001
Turion Il P520, 2.3-GHz, 2-MB L2 cache Dual-Core (25W) 594173-001
Phenom Il P820, 1.8-GHz, 1.5-MB L2 cache, Tri-Core (25W) 594167-001
Phenom Il P920, 1.6-GHz, 2-MB L2 cache Quad-Core (25W) 594170001

Before removing the processor, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.
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3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Remove the thermal shield (see Thermal shield on page 56).

N o w &

Remove the heat sink and fan (see Heat sink and fan on page 61).

B NOTE: It is not necessary to disconnect the keyboard to remove the procesor.

Remove the processor:
1. Position the computer rightside up with the front toward you.

2. Use a flat-bladed screwdriver to turn the processor locking screw (1) one-half turn
counterclockwise until you hear a click.

3. Lift the processor (2) straight up and remove it.

Ef NOTE: When you install the processor, the gold triangle (3) on the processor must be aligned
with the triangle (4) embossed on the processor socket.

Reverse this procedure to install the processor.
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Palm rest

Description Spare part number
Palm rest for 15.6-in displays (includes TouchPad) 598688-001
Palm rest for 15.6-in displays with red trim (includes TouchPad) 604852-001
Palm rest for 15.6-in displays with fingerprint reader (includes TouchPad) 599804-001
Palm rest for 15.6-in displays with fingerprint reader with red trim (includes TouchPad) 604861-001

Before removing the palm rest, follow these steps:

4.
5.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Remove the palm rest:

Position the computer right-side up with the front toward you.
Remove the three Phillips PM2.0x3.0 screws (1) that secure the palm rest to the computer.

Slide the palm rest to the right (2), and then lift and rotate the rear edge (3) towards the display
to gain access to the TouchPad cable.
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4. Release the ZIF connectors (1) and (3) to which the TouchPad and fingerprint cables are
connected, and then disconnect the cables (2) and (4) from the system board.

Ef NOTE: Only select models are equipped with fingerprint readers.

5. Remove the palm rest.

Reverse this procedure to install the palm rest.
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Hard drive

B NOTE: The hard drive spare part kit includes a hard drive bracket.

Description Spare part number
750-GB, 5400-rpm hard drive 616289-001

640-GB, 5400-rpm hard drive 617439-001

500-GB, 7200-rpm hard drive 616288-001

320-GB, 7200-rpm hard drive 616287001

250-GB, 7200-rpm hard drive 6162865-001

Before removing the hard drive, follow these steps:

I’?{

6.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the Switch cover and keyboard (see Switch cover and keyboard on page 46).

NOTE: It is not necessary to disconnect the keyboard cable from the system board when
removing the hard drive.

Remove the palm rest (see Palm rest on page 67).

Remove the hard drive:

Position the computer right-side up with the front toward you.

Remove the two Phillips PM2.5x6.0 screws (1) and loosen the Phillips PM2.5x11.0 captive screw
(2) that secure the hard drive to the computer.

Grasp the mylar tab on the hard drive and slide the hard drive (3) to the right to disconnect it
from the system board.
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4. Remove the hard drive (4) from the hard drive bay.

5. |Ifitis necessary to replace the hard drive bracket, remove the two Phillips PM3.0x4.0 hard drive
bracket screws (1) from each side of the hard drive.

6. Llift the bracket (2) straight up to remove it from the hard drive.

Reverse this procedure to reassemble and install the hard drive.
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Display assembly on computers with 15.6-in displays

Ef NOTE: The Miscellaneous LCD Cable Kit, spare part number 599806-001, includes 2 WLAN

antenna transceivers and cables.

Description

Spare part number

For use only with computers with 15.6-in displays

e 15.6-in HD BrightView display assembly for use in computers equipped with webcam and 613219001
WWAN (1366x768 resolution)

e 15.6-in HD BrightView display assembly for use in computers with webcam (1366x768 613218-001
resolution)

e 15.6-in HD BrightView display assembly (1366x768 resolution) 613215001

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and 613217-001
WWAN (1366x768 resolution)

e  15.6-in HD AntiGlare display assembly for use in computers equipped with webcam 613216-001
(1366x768 resolution)

e 15.6-in HD AntiGlare display assembly (1366x768 resolution) 613214-001

e 15.6-in HD BrightView display assembly for use in computers with webcam, WWAN, and red  613230-001
trim (1366x768 resolution)

e  15.6-in HD BrightView display assembly for use in computers with webcam and red trim 613229-001
(1366x768 resolution)

e 15.6-in HD BrightView display assembly for use in computers with red trim (1366x768 613226001
resolution)

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam, WWAN,  613228-001
and red trim (1366x768 resolution)

e 15.6-in HD AntiGlare display assembly for use in computers equipped with webcam and red ~ 613227-001
trim (1366768 resolution)

e 15.6-in HD AntiGlare display assembly for units with red trim (1366x768 resolution) 613225-001

Before removing the 15.6-in display assembly, follow these steps:

1.

2,

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the

computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet

and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Disconnect the power button cable from the system board (see Power button board on page 53).
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7. Remove the speakers (see Speakers on page 55)

8. Remove the thermal shield (see Thermal shield on page 56).

Remove the display cables:

1. Remove the tape that holds the cables in place (1). Disconnect the display and webcam cables
from the system board and from the routing channels.

2. Disconnect the cable connectors for the display (2) and microphone (3) from the system board.

3. Disconnect the WLAN and WWAN cables (4) from the tape and from the routing channels built
info the top cover.

Remove the display assembly:
1. Position the computer rightside up with the front toward you.

2. Open the computer as far as possible.

A CAUTION: Support the display assembly when removing the retaining screws. Failure to
support the display assembly can result in damage to the display assembly and other computer
components.

3. Remove the six Torx M2.5x6.0 screws (1) that secure the display assembly to the computer.
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4. lift the display assembly up and off the computer (2).

5. Ifitis necessary to replace the display bezel, display enclosure, or display hinges, remove the two
mylar screw covers (1) and the 2 Torx M2.5x6.0 screws (2) that secure the display bezel to the
display assembly. The screw covers are available in the Rubber Kit, spare part number
598678-001.
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6. Flex the bottom bezel (1) around the hinge areas on the inside of the display enclosure and work
around the periphery of the bezel (2) and (3).
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7. Lift the bezel (4) until it disengages completely.

8. |Ifitis necessary fo replace the webcam module, gently pull the webcam module away from the
double-sided tape on the display enclosure (1) and disconnect the webcam cable from the module
(2). The webcam module and cable can be ordered by using spare part number 598671-001.

B NOTE: To replace the webcam module in the display enclosure, align the holes on the webcam
module with the pins on the display enclosure and press onto the double-sided tape.

9. Ifitis necessary to replace the display hinges, remove the Torx screws (1) at the top and bottom
of the display that secure the display to the display housing.
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10. Remove the display panel from the housing (2).
T—\

e

11. Remove the six Phillips PM2.0x3.0 screws (1) that secure the display hinges to the display panel,
and then remove the display hinges (2). The left and right display hinges are available in the
Hinge Kit, spare part number 598679-001 for computers with 15.6-in displays.

To replace the webcam, webcam cable, and display cable:

1. Remove the microphone from its socket (1) and lift its cable (2) from the raceway.
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2. Remove the webcam cable (3) from the raceway and then, remove the cable assembly (4).

B NOTE: The cables are attached to the display panel with adhesive tape.

? ol of .

ot

To remove the WLAN and WWAN antennas:
1. Peel the WLAN (1) and WWAN (2) antenna receivers from the housing.

2. Route the antenna cables (3) out of the routing channels in the inside of the display housing.

|
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Reverse this procedure to install the display assembly.
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Top cover
The spare part number for the top cover is 598682-001.
Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

6. Remove the optical drive (see Optical drive on page 51).

7. Remove the power button board cable (see Power button board on page 53).

8. Remove the speakers (see Speakers on page 55).

9. Remove the thermal shield (seeThermal shield on page 56 ).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the following components:
Remove the top cover on 15.6-in computers:

1. Position the computer rightside up with the front toward you.
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2. Disconnect the power button board cable from the system board by releasing the ZIF connector
(1), and then disconnecting the cable (2).

3. Remove the 10 Torx M2.5x6.0 screws that secure the top cover to the computer.
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4. Remove the ExpressCard bezel (1), then angle the top cover up (2), and lift it up (3) until it
disengages from the base enclosure.

Reverse this procedure to install the top cover.
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RTC battery
The spare part number for the RTC battery is 616073-001.
Before removing the RTC battery, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

6. Remove the optical drive (see Optical drive on page 51).

7. Remove the power button board cable (see Power button board on page 53).

8. Remove the speakers (see Speakers on page 55).

9. Remove the thermal shield (see Thermal shield on page 56).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the top cover (see Top cover on page 77).

Remove the RTC battery:

1. Position the computer right-side up with the front toward you.
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2. Release the RTC battery from the socket (1) on the system board and lift the battery (2) up.

Reverse this procedure to install the RTC battery.
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Bluetooth module

82

The spate part number for the Bluetooth module is 537921-001.

B NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 613224-001. See Cable Kits
on page 28 for more Cable Kit spare part number information.

Before removing the Bluetooth module, follow these steps:

1.

w
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10.

11.
12.
13.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Remove the optical drive (see Optical drive on page 51).

Remove the power button board cable (see Power button board on page 53).

Remove the speakers (see Speakers on page 55).

Remove the thermal shield (see Thermal shield on page 56).

Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

Remove the palm rest (see Palm rest on page 67).

Remove the hard drive (see Hard drive on page 69).

Remove the top cover (see Top cover on page 77).

Remove the Bluetooth module:

1.
2,

Position the computer rightside up with the front toward you.

Disconnect the Bluetooth cable (1) from the system board and from the antenna (2).
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3. Remove the Bluetooth antenna (3) from the base enclosure.
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Reverse this procedure to install the Bluetooth module.

Modem module

Description Spare part number
For use in all countries and regions except Australia and New Zealand 510100-001
For use only in Australia and New Zealand 510100-011

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

6. Remove the optical drive (see Optical drive on page 51).
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7. Remove the power button board cable (see Power button board on page 53).

8. Remove the speakers (see Speakers on page 55).

9. Remove the thermal shield (see Thermal shield on page 56).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the top cover (see Top cover on page 77).

Remove the modem module:
1. Position the computer rightside up with the front toward you.

2. Remove the two Phillips PM2.5x3.0 screws (1) that secure the modem module to the system

board.
3. Lift the modem module (2) straight up from the system board.

4. Disconnect the modem module cable (3). The modem module cable is spared in the Cable kit
spare part number 613224-001.

5. Remove the modem module.

Reverse this procedure to install the modem module.
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Audio board
B’ NOTE: The spare part number for the audio board is 598684-001.

Before removing the audio board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

6. Remove the optical drive (see Optical drive on page 51).

7. Remove the power button board cable (see Power button board on page 53).

8. Remove the speakers (see Speakers on page 55).

9. Remove the thermal shield (see Thermal shield on page 56).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the top cover (see Top cover on page 77).

Remove the audio board:
1. Position the computer rightside up with the front toward you.
2. Remove the M2.5x3.0 screw (1) that secures the audio board to the system board.

3. Release the ZIF connector (2) and remove the cable (3).
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4. Remove the audio board (4) by pulling the module straight up and off the computer.

Reverse this procedure to install the audio board.
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System board

Ef NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number
System board with UMA graphics and RTC battery 613211001
System board with UMA graphics, WWAN capability, and RTC battery 613212001
System board with discrete graphics and RTC battery 613212001

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

. Remove the battery (see Battery on page 45).

. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

. Remove the optical drive (see Optical drive on page 51).

. Remove the speakers (see Speakers on page 55).

4
5
6
7. Remove the power button board cable (see Power button board on page 53).
8
9

. Remove the thermal shield (see Thermal shield on page 56).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the top cover (see Top cover on page 77).

When replacing the system board, be sure that the following components are removed from the
defective system board and installed on the replacement system board:

e Memory module (see Memory module on page 50)

e WILAN module (see WLAN module on page 58)

e WWAN module (see WWAN module on page 59)

e  Modem module (see Modem module on page 83)

e  Processor (see Processor on page 65)

e Audio board (see Audio board on page 85)
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Remove the system board:
1. Position the computer rightside up with the front toward you.

Remove the M2.0x3.0 screw on the left of the system board (1).

2
3. Remove the M2.0x2.5 screw (2) that secures the optical drive extender to the base enclosure.
4. Llift the board at an angle (3) and remove the optical drive extender (4).

5

Slide the board partially out of the base pan (5).

7

88 Chapter 4 Removal and replacement procedures



6. Disconnect the power cable (1) from the system board and the connector (2) from the computer.
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Remove the screw (1) that secures the USB to the computer, disconnect the cable (2) from the
system board and then, remove the device (3) from the computer.

Reverse this procedure to install the system board.

USB connector assembly

90

The USB connector assembly is included in the Cable Kit, spare part number 613224-001 for
computers with 15.6-in displays.

Before removing the USB connector assembly, follow these steps:

1.

w
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Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

Remove the optical drive (see Optical drive on page 51).

Remove the power button board cable (see Power button board on page 53).

Remove the speakers (see Speakers on page 55).
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9.
10.

11.
12.
13.

Remove the thermal shield (see Thermal shield on page 56).

Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

Remove the palm rest (see Palm rest on page 67).

Remove the hard drive (see Hard drive on page 69).

Remove the top cover (see Top cover on page 77).

Remove the USB connector assembly:

1.
2.

Position the computer right-side up with the right side toward you.

Remove the Phillips PM2.5x3.0 screw (1) that secures the USB connector assembly to the base
enclosure.

Disconnect the cable from the system board (2).

Remove the USB connector assembly (3) from the base enclosure.

Reverse this procedure to install the USB connector assembly.

RJ-11 connector assembly

B NOTE: The RJ-11 connector assembly is included in the Base Cable Kit, spare part number
613224-001 for 15.6-in computers.
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Before removing the RJ-11 connector assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

4. Remove the battery (see Battery on page 45).

5. Remove the switch cover and keyboard (see Switch cover and keyboard on page 46).

6. Remove the optical drive (see Optical drive on page 51).

7. Remove the power button board cable (see Power button board on page 53).

8. Remove the speakers (see Speakers on page 55).

9. Remove the thermal shield (see Thermal shield on page 56).

10. Remove the display assembly (see Display assembly on computers with 15.6-in displays
on page 71).

11. Remove the palm rest (see Palm rest on page 67).

12. Remove the hard drive (see Hard drive on page 69).

13. Remove the top cover (see Top cover on page 77).

Remove the RJ-11 connector assembly:
1. Position the computer right-side up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the cable from the routing channel in
the base enclosure.
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3.

Lift the RJ-11 connector (2) from its holder and out of the base enclosure.
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Reverse this procedure to install the RJ-11 connector assembly.

Power connector assembly

Bf NOTE: DThe power connector assembly is included in the Base Cable Kit, spare part number
613224-001 for computers wit 15.6-in displays.

Before removing the power connector assembly, follow these steps:

1.

Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

Disconnect all external devices connected to the computer.

Disconnect the power from the computer by first unplugging the power cord from the AC outlet
and then unplugging the AC adapter from the computer.

Remove the battery (see Battery on page 45).

Remove the following components:

a. Switch cover and keyboard (see Switch cover and keyboard on page 46)

b. Optical drive (see Optical drive on page 51)

c. Power button board cable (see Power button board on page 53)

d. Speakers (see Speakers on page 55)
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e. Thermal shield (see Thermal shield on page 56)

f. Display assembly (see Display assembly on computers with 15.6-in displays on page 71)

Palm rest (see Palm rest on page 67)

T @

Hard drive (see Hard drive on page 69)

Top cover (see Top cover on page 77)
Remove the power connector assembly:
1. Position the computer rightside up with the right side toward you.

2. Disconnect the cable from the system board (1) and remove the tape and cable from the routing
channel in the base enclosure.

3. Lift the power connector (2) from the base enclosure.

Reverse this procedure to install the power connector.
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5 Computer Setup

Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system
is not working or will not load.

B NOTE: Some of the Computer Setup menu items listed in this guide may not be supported by your
computer or your operating system.

NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, and System
Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

e To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

e To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

e To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.
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B’ NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the
keyboard to navigate and make selections in Computer Setup.

2. Press {10 to enter BIOS Setup.
3. Select the File, Security, or System Configuration menu.
To exit Computer Setup menus, choose one of the following methods:

e To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then press
enter.

e To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

—or —

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then press
enter.

Your changes go into effect when the computer restarts.

Restoring factory settings in Computer Setup

Ef NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

Press f10 to enter BIOS Setup.
Use a pointing device or the arrow keys to select File > Restore Defaults.

Follow the on-screen instructions.

LA

To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

B NOTE: Your password seftings and security settings are not changed when you restore the factory
settings.
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Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options.

B NOTE: Some of the Computer Setup menu items listed in this chapter may not be supported by your
computer or your operating system.

File menu

Select To do this

System Information e View identification information for the computer and the

batteries in the system.

e  View specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

System Diagnostics Displays the following information:

e  System information
o |dentification information for the computer and the

batteries in the system.

o Specification information for the processor, cache
and memory size, system ROM, video revision, and
keyboard controller version.

e  Startup Test—Verifies the system components needed for
starting the computer.

e  Run-in Test—Runs a comprehensive check on system
memory.

e  Hard Disk Test—Runs a comprehensive self-test on any
hard drive in the system.

e  Memory Test—Runs a comprehensive test on any
memory installed in the computer.

e  Battery Test—Runs a comprehensive test on any batteries
installed in the computer.

Error Log—Displays a log file if any errors have

occurred.

Restore Defaults Replace the configuration settings in Computer Setup with the
original factory settings. (Hard drive mode, password settings,
and security seftings are not changed when you restore the
factory settings.)

Reset BIOS security to factory default Restore the BIOS security settings to the factory default.
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Select

To do this

Ignore Changes and Exit

Cancel any changes entered during the current session. Then
exit and restart the computer.

Save Changes and Exit

Save any changes entered during the current session. Then
exit and restart the computer. Your changes go into effect
when the computer restarts.
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Security menu

B NOTE: Some of the menu items listed in this section may not be supported by your computer or your

operating system.

Select

To do this

Setup BIOS Administrator Password

Set up a BIOS administrator password.

User Management > Create a New BIOS User Account
(requires a BIOS administrator password)

e  Select from a list of BIOS users.

o  Select from a list of ProtectTools users.

Password Policy (requires a BIOS administrator password)

Revise password policy criteria.

HP SpareKey

Enable/disable HP SpareKey (disabled by default).

Fingerprint Reset on Reboot (If Present)

Reset/clear the fingerprint reader ownership (select models
only; disabled by default).

Change Password

Enter, change, or delete a BIOS administrator password.

HP SpareKey Enrollment

Enroll or reset HP SpareKey, which is a set of security
questions and answers used if you forget your password.

Anti Theft > AT-p (select models only)

Enable/disable Anti-theft Protection.

Drivelock Password

e  Enable/disable Drivelock on any computer hard drive

(enabled by default).

e  Change a Drivelock user password or master password.

NOTE: Drivelock seftings are accessible only when you
enter Computer Setup by turning on (not restarting) the
computer.

Automatic Drivelock

Enable/disable Automatic Drivelock support (disabled by
default).

Disk Sanitizer

Run Disk Sanitizer to destroy all existing data on the primary
hard drive or the drive in the upgrade bay.

CAUTION: If you run Disk Sanitizer, the data on the
selected drive is destroyed permanently.

System IDs

Enter a user-defined computer asset tracking number and
ownership tag.
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System Configuration menu

100

Ef NOTE: Some of the listed System Configuration options may not be supported by your computer or

your operating system.

Select To do this
Language Change the Computer Setup language.
Boot Options e  Seta startup menu delay (in seconds).

Set the MultiBoot Express Boot Popup delay in seconds.
Enable/disable custom logo (disabled by default).

Enable/disable display diagnostic URL (enabled by
default).

Enable/disable CD-ROM boot (enabled by default).
Enable/disable SD card boot (enabled by default).
Enable/disable floppy boot (enabled by default).

Enable/disable PXE internal NIC boot (enabled by
default).

Enable/Disable Unified Extensible Firmware Interface
(UEFI) Boot Mode (disabled by default).

Set the legacy boot order.

Chapter 5 Computer Setup



Select To do this

Device Configurations e  Enable/disable USB legacy support (enabled by default).
When enabled, USB legacy support allows the following:

o Use of a USB keyboard in Computer Setup even
when a Windows operating system is not running.

o Startup from bootable USB devices, including a
hard drive, diskette drive, or optical drive
connected by a USB port to the computer.

e  Select a parallel port mode: ECP (Enhanced Capabilities
Port), standard, bidirectional, or EPP (Enhanced Parallel
Port).

e  Enable/disable fan always on while connected to an AC
outlet (enabled by default).

e  Enable/disable Data Execution Prevention (select models
only). When enabled, the processor can disable some
virus code execution, which helps to improve computer
security (enabled by default).

e  Select a SATA (Serial Advanced Technology Attachment)
device mode. The following options are available:

o AHCI (Advanced Host Controller Interface)
o IDE (Infegrated Drive Electronics)

> RAID (Redundant Array of Independent Disks) (select
models only)
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Select

To do this

NOTE: Availability of these options above varies by
computer model.

e  Enable/disable secondary battery fast charge (enabled
by default).

e  Enable/disable HP Quicklook 2 (enabled by default).

e  Enable/disable preboot authentication on HP QuickLock
boot (enabled by default).

e  Enable/disable HP QuickWeb (enabled by default).

e  Enable/disable HP QuickWeb write protect (disabled by
default).

e  Enable/disable virtualization technology (select models
only; disabled by default).

e  Enable/disable Intel TXT (Trust Execution Technology)
(select models only; disabled by default).

e  Enable/disable Multi Core CPU (enabled by default).
e  Enable/disable Intel HT technology (enabled by default).
e  Enable/disable wake on USB (enabled by default).

e  Enable/disable Num lock state at boot (disabled by
default).
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Select

To do this

Built-In Device Options

Enable/disable the wireless button state (enabled by
default).

Enable/disable embedded WWAN device (select
models only; enabled by default).

Enable/disable embedded WLAN device (enabled by
default).

Enable/disable embedded Bluetooth device (enabled by
default).

Enable/disable the network interface controller (LAN)
(enabled by default).

Enable/disable LAN/WLAN switching (disabled by
default).

Set the wake on LAN state. Options include the
following:

Disabled
o Boot to Network (default setting)
Follow Boot Order

Enable/disable the ambient light sensor (enabled by
default).

Enable/disable the notebook upgrade bay device
(enabled by default).

Enable/disable the fingerprint device (enabled by
default).

Enable/disable the integrated camera (enabled by
default).

Enable/disable the power monitor circuit (enabled by
default).

Enable/disable the audio device (enabled by default).
Enable/disable a modem device (enabled by default).
Enable/disable the microphone (enabled by defaul).

Enable/disable the internal speakers (enabled by
default).
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Select

To do this

Port Options

NOTE: All port options are enabled by default.

Enable/disable the serial port (select models only).
Enable/disable the parallel port (select models only).
Enable/disable the flash media reader.
Enable/disable the USB port.

CAUTION: Disabling the USB port also disables
MultiBay devices and ExpressCard devices on the
advanced port replicator.

Enable/disable the 1394 port (select models only).

Enable/disable the ExpressCard slot (select models only).

Enable/disable the eSATA port (select models only).

AMT Options (select models only)

NOTE: All AMT options are disabled by default.

Enable/disable firmware verbosity.
Enable/disable AMT setup prompt (Cirl-P)
Enable/disable USB key provisioning support.
Enable/disable unconfigure AMT on next boot.

Select terminal emulation mode. Options include the
following:

o ANSI (default setting)
> VT100
Enable/disable firmware progress event support.

Enable/disable initiate Intel CIRA.

Set Security Level

Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults

Restore the default security seftings.
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6 Specifications

Computer specifications

Metric u.s.
Dimensions - 15.6-in
Depth 24.96 cm 9.83in
Width 37.18 cm 14.6 in
Height (front to rear) 2.77 to 3.55 cm 1.09 to 1.40 in
Weight - 15.6-in (equipped with optical drive, WXGA < 2.5 kg <5.51bs

display assembly, 1 memory module, hard drive, and é-cell

battery)

Input power

Operating voltage

18.5Vdc@4.74 A-90 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F
Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F

Nonoperating

-20°C to 60°C

-4°F to 140°F

Relative humidity

Operating

10% to 90%

Nonoperating

5% to 95%

Maximum altitude (unpressurized)

Operating

-15mito0 3,048 m

-50 ft to 10,000 ft

Nonoperating

-15mit012,192 m

-50 ft to 40,000 ft

Shock

Operating

125 g, 2 ms, halfsine

Nonoperating

200 g, 2 ms, halfsine

Random vibration

Computer specifications
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Metric u.s.

Operating 0.75 g zero+o-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep
rate

Nonoperating 1.50 g zero+o-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep
rate

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this
range of temperatures.
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15.6-in display specifications

Metric uU.s.
Dimensions
Height 21.0 cm 8.3in
Width 35.98 cm 14.2'in
Diagonal 39.1 cm 15.6 in
Number of colors Up to 16.8 million
Contrast ratio 500:1 (min BrightView), 300:1 (min AntiGlare))
Brightness 200 nits (typical)
Pixel resolution
Format 1366 x 768
Configuration RGB
Backlight LED
Response Time 8 ms (typ)
Total power consumption 4.1 W (max)
Viewing angle @ CR>10 SVA
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Hard drive specifications
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500-GB* 320-GB* 250-GB* 160-GB*
Dimensions
Height 9.5 mm 9.5 mm 9.5 mm 9.5 mm
Width 70 mm 70 mm 70 mm 70 mm
Weight 101 g 101 g 101 g 101 g
Interface type SATA SATA SATA SATA
Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec
Security ATA security ATA security ATA security ATA security
Seek times (typical read, including setting)
Single track 3 ms 3 ms 3ms 3 ms
Average 13 ms 13 ms 13 ms 13 ms
Maximum 24 ms 24 ms 24 ms 24 ms
Logical blocks 1,048,576,000 625,141,400 488,376,280 312,560,640
Disc rotational speed 5400 rpm 5400 rpm 7200 and 5400 7200 and 5400

rpm rpm

Operating temperature 5°C to 55°C 5°C to 55°C 5°C to 55°C 5°C to 55°C

(41°Fto 131°F)

(41°F to 131°F)

(41°Fto 131°F)

(41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less. Actual drive

specifications may differ slightly.

NOTE:

Certain restrictions and exclusions apply. Contact technical support for details.
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DVD-ROM Drive specifications

Applicable disc DVD-ROM (DVD-5, DVD-9, DVD-10, DVD-18, CD-ROM (Mode 1 and 2), CD Digital Audio,
CD-XA ready (Mode 2, Form 1 and Form 2), CD-l (Mode 2, Form 1 and Form 2), CD-R,
CD-RW, Photo CD (single and multisession), CD-Bridge

Access time cD DVD
Random < 100 ms <125 ms
Cache buffer 512 KB

Data transfer rate

CDR (24X) 3600 KB/s (150 KB/s at 1X CD rate)
CD-RW (10X) 1500 KB/s (150 KB/s at 1X CD rate)
CD-ROM (24X) 3600 KB/s (150 KB/s at 1X CD rate)

DVD (8X) 10,800 KB/s (1,352 KB/s at 1X DVD rate)
Multiword DMA mode 2 16.6 MB/s
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DVD+RW Double-Layer Combo Drive specifications
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Applicable disc

Read:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT, CD-ROM,
CD-ROM XA, MIXED MODE CD, CD, CD-l
Bridge (Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CDR, CD-RW),
CDR, CD-RW, DVD-ROM (DVD-5, DVD-9,
DVD-10, DVD-18), DVDR, DVD-RW, DVD+R,
DVD+RW, DVD-RAM

Write:
CD-R and CDRW

DVD+R, DVD+RW, DVD-R, DVD-
RW, DVD-RAM

Access time cD DVD
Random <175 ms <230 ms
Cache buffer 2 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CD-R 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVDR 10,800 KB/sec
4X DVD-RW 5,400 KB/sec
2.4X DVD+R(9) 2,700 KB/sec
5X DVD-RAM 6,750 KB/sec

Transfer mode

Multiword DMA Mode
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Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW
Double-Layer specifications

Applicable disc

Read:

Write:

CD-DA, CD+(E)G, CD-MIDI, CD-TEXT,
CD-ROM, CD-ROM XA,

MIXED MODE CD, CD-l, CD-l Bridge
(Photo-CD, Video CD), Multisession CD
(Photo-CD, CD-EXTRA, Portfolio, CD-R,
CD-RW), CD-R, CD-RW, DVD-

ROM (DVD-5, DVD-9, DVD-10,
DVD-18), DVD-R, DVD-RW, DVD+R,
DVD+RW, DVD-RAM, HD-

ROM (Single Layer), HD-ROM (Dual
Layer), HD DVD-R, HD DVD-R for

Dual Layer, HD DVD-RW, BD-ROM, BD-

CD-R and CD-RW DVD+R, DVD+R (9),
DVD+RW, DVD-R, DVD-R (9), DVD-RW,
DVD-RAM

R, BR-RE
Access time cD DVD HD
Random 170 ms 170 ms 230 ms
Cache buffer 8 MB

Data transfer rate

24X CD-ROM 3,600 KB/sec
8X DVD-ROM 10,800 KB/sec
24X CDR 3,600 KB/sec
16X CD-RW 2,400 KB/sec
8X DVD+R 10,800 KB/sec
4X DVD+RW 5,400 KB/sec
8X DVDR 10,800 KB/sec
4X DVD-RW 5,400 KB/sec

2.4X DVD+R(9)

2,700 KB/sec

5X DVD-RAM 6,750 KB/sec
1X BD-ROM 4,500 KB/sec
1X BDR read 4,500 KB/sec

1X BD-RE read

4,500 KB/sec

Transfer mode

Multiword DMA Mode

Blu-ray Disc ROM Drive with SuperMulti DVD+R/RW Double-Layer specifications 111



7 Backup and recovery

Backup and recovery in Windows 7

Overview

To protect your information, use the Windows Backup and Restore to back up individual files and
folders, back up your entire hard drive (select models only), create system repair discs (select models
only), or create system restore points. In case of system failure, you can use the backup files to restore
the contents of your computer.

Windows Backup and Restore provides the following options:
e Creating a system repair disc (select models only)

e  Backing up individual files and folders

e Creating a system image (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e  Restoring the computer to a previous state

e  Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
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Recovery after a system failure is as complete as your most current backup. You should create system
repair discs (select models only) and your initial backup immediately after software setup. As you add
new software and data files, you should continue to back up your system on a regular basis to maintain
a reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:
e  Store personal files in the Documents folder, and back it up regularly.
e  Back up templates that are stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive installed in your computer.

Ef NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore , follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

B NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Windows Backup and Restore to recover information
you have previously backed up. You can also use Windows Startup Repair to fix problems that
might prevent Windows from starting correctly.

e {11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

B NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

Using the Windows recovery tools
To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your entire computer (select
models only), or your files.

Ef NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

A CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
Al files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.
2. |If possible, check for the presence of the Windows partition and the HP Recovery partition.
e To check for the Windows partition, select Start > Computer.

e  To check for the HP Recovery partition, select Start , rightclick Computer , click Manage,
and then click Disk Management.

B NOTE: If the Windows partition and the HP Recovery partition are not listed, you must recover
your operating system and programs using the Windows 7 operating system DVD and the Driver
Recovery disc (both purchased separately). For additional information, refer to the “Using a
Windows 7 operating system DVD (purchased separately)” section in this guide.

3. If the Windows partition and the HP Recovery partition are listed, restart the computer, and then
press {8 before the Windows operating system loads.
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4. Select Startup Repair.

5. Follow the on-screen instructions.

B NOTE: For additional information on recovering information using the Windows tools, perform a

search for these topics in Help and Support.

Using f11
A CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files

Using

you have created and any software installed on the computer are permanently removed. The {11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: select Start, right-click
Computer, click Manage, and then click Disk Management.

Ef NOTE: If the HP Recovery partition is not listed, you must recover your operating system and
programs using the Windows 7 operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows 7 operating
system DVD (purchased separately)” section in this guide.

3. [f the hP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press {11 to enter HP Recovery.

5. Follow the on-screen instructions.

a Windows 7 operating system DVD (purchased separately)

If you are unable to boot (start up) your computer and you cannot use the system repair discs you
previously created (select models only) , you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. Make sure that your most recent backup (stored
on discs or on an external drive) is easily accessible. To order a Windows 7 operating system DVD, go
to http://www.hp.com/support, select your country or region, and follow the on-screen instructions.
You can also order the DVD by calling technical support. For contact information, refer to the
Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD, follow these steps:
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B NOTE: This process takes several minutes.

1. |If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

When prompted, press any keyboard key.
Follow the on-screen instructions.
Click Next.

Select Repair your computer.

N w bW

Follow the on-screen instructions.

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders,
back up your entire hard drive (select models only), or create system restore points. In case of system
failure, you can use the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:
e  Backing up individual files and folders

e Backing up the entire hard drive (select models only)

e  Scheduling automatic backups (select models only)

e  Creating system restore points

e  Recovering individual files

e  Restoring the computer to a previous state

e  Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information
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Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.
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Note the following when backing up:
e  Store personal files in the Documents folder, and back it up regularly.
e  Back up templates that are stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.

To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:
To copy only the active window, press alt+fn+prt sc.
To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.
The screen image is added to the document.

4. Save the document.

e When backing up to discs, use any of the following types of discs (purchased separately): CDR,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD+RW. The discs you use will depend on the
type of optical drive installed in your computer.

Ef NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

e When backing up to discs, number each disc before inserting it into the optical drive of the
computer.

To create a backup using Backup and Restore Center, follow these steps:

B NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

149,

Ef NOTE: Windows includes the User Account Control feature to improve the security of your
computer. You may be prompted for your permission or password for tasks such as installing
software, running utilities, or changing Windows settings. Refer to Help and Support for more
information.
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Performing a recovery

[@;

In case of system failure or instability, the computer provides the following tools to recover your files:

e  Windows recovery tools: You can use the Backup and Restore Center to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

e {11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: |If you are unable to boot (start up) your computer, you must purchase a Windows Vista®
operating system DVD to reboot the computer and repair the operating system. For additional
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)”
section in this guide.

Using the Windows recovery tools
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To recover information you previously backed up, follow these steps:
1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive.
Al files you have created and any software installed on the computer are permanently removed. When
reformatting is complete, the recovery process restores the operating system, as well as the drivers,
software, and utilities from the backup used for recovery.

1. |If possible, back up all personal files.

2. |If possible, check for the presence of the Windows partition and the HP Recovery partition. To find
the partitions, select Start > Computer.

B NOTE: If the Windows partition and the HP Recovery partition have been deleted, you must
recover your operating system and programs using the Windows Vista operating system DVD and
the Driver Recovery disc (both purchased separately). For additional information, refer to the
“Using a Windows Vista operating system DVD (purchased separately)” section in this guide.

3. Restart the computer, and then press {8 before the Windows operating system loads.
4. Select Repair your computer.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.
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Using
A

Using

f11

CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files
you have created and any software installed on the computer are permanently removed. The {11
recovery tool reinstalls the operating system and HP programs and drivers that were installed at the
factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using 11, follow these steps:
1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select Start
> Computer.

B NOTE: If the HP Recovery partition has been deleted, you must recover your operating system
and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both
purchased separately). For additional information, refer to the “Using a Windows Vista operating
system DVD (purchased separately)” section in this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

4. Press 11 to enter HP Recovery.

5. Follow the on-screen instructions.

a Windows Vista operating system DVD (purchased

separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating
system DVD to reboot the computer and repair the operating system. Make sure that your most recent
backup (stored on discs or on an external drive) is easily accessible. To order a Windows Vista
operating system DVD, go to http://www.hp.com/support, select your country or region, and follow
the on-screen instructions. You can also order the DVD by calling technical support. For contact
information, refer to the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical
drive before the Windows operating system loads.

3. When prompted, press any keyboard key.
4. Follow the on-screen instructions.

5. Click Next.
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6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows® Backup utility (select models only) to back up files and
folders or create recovery points. In case of system failure, you can use the backup files to restore your
computer.

Windows provides the following options:

e  Backing up individual files and folders
e  Backing up all files and folders

e  Scheduling automatic backups

e  Creating recovery points

e  Recovering information

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

NOTE: In case of system instability, HP recommends that you print the recovery procedures and save
them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your
initial backup immediately after software setup. As you add new software and data files, you should
continue to back up your system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.
Note the following when backing up:

e  Store personal files in the My Documents folder, and back it up periodically.

e  Back up templates stored in their associated programs.

e Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it info a word-processing document:
a. Display the screen you want to save.
b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.
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The screen image is added to the document.
d. Save the document.

To create a backup using the Windows Backup utility (select models only), follow these steps:

Ef NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of the
computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

e Windows recovery tools (select models only): You can use the Windows Backup utility to recover
information you have previously backed up.

e  Operating System and Driver Recovery discs (included with your computer): You can use the discs
to recover your operating system and programs installed at the factory.

Recovering your information
To recover information you previously backed up, follow these steps:
1. |If possible, back up all personal files.
2. Click Start > All Programs > Accessories > System Tools > Backup.
The Backup or Restore Wizard opens.
3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

B NOTE: For additional information on initiating a recovery in Windows, perform a search for this
topic in Help and Support.

Recovering the operating system and programs

A CAUTION: The recovery process reformats and completely erases the hard drive. All files you have
created and any software installed on the computer are permanently removed. The recovery process
reinstalls the original operating system, software, and drivers. Software, drivers, and updates not
installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:
1. |If possible, back up all personal files.
2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.
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Turn on the computer.
Follow the on-screen instructions to install the operating system.

After the operating system is installed, remove the Operating System disc and insert the Driver
Recovery disc.

Follow the on-screen instructions to install the drivers and programs.
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8 Connector pin assignments

Audio-in (microphone)

Pin Signal
1 Audio signal in
2 Audio signal in
3 Ground

Audio-out (headphone)

Pin Signal

1 Audio out, left channel
2 Audio out, right channel
3 Ground
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External monitor

@O O00®
®000 W
©000®G

Pin Signal

1 Red analog

2 Green analog
3 Blue analog

4 Not connected
5 Ground

6 Ground analog
7 Ground analog
8 Ground analog
9 +5 VDC

10 Ground

11 Monitor detect
12 DDC 2B data
13 Horizontal sync
14 Vertical sync
15 DDC 2B clock
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HDMI

1917151311 9 7 5 3 1

oo oooooo

1816 1412 10 8 & 4 2

Pin Signal

1 Transition minimized differential signal (TMDS) data 2+
2 TMDS data 2 shield

3 TMDS data 2-

4 TMDS data 1+

5 TMDS data 1 shield

6 TMDS data 1-

7 TMDS data O+

8 TMDS data O shield

9 TMDS data O-

10 TMDS clock+

11 TMDS clock shield

12 TMDS clock-

13 Consumer electronic control (CEC)
14 Not connected

15 DDC clock

16 DDC data

17 Ground

18 +5V power

19 Hot plug detect
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RJ-11 (modem)

123456

Pin Signal
1 Unused
2 Tip

3 Ring

4 Unused
5 Unused
6 Unused

RJ-11 (modem)
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RJ-45 (network)

LTETTT
12345678
g —

Pin Signal
1 Transmit +
2 Transmit -
3 Receive +
4 Unused
5 Unused
6 Receive -
7 Unused
8 Unused

Universal Serial Bus

1 2 3 4
I--_-_-.I

Pin Signal
1 +5 VDC
2 Data -
3 Data +
4 Ground
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9 Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to

120 volts AC or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:

The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.

Requirements for all countries and regions
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
ltaly IMQ 1
Japan METI 3
The Netherlands KEMA 1
Norway NEMKO 1
The People's Republic of China CCcC 5
South Korea EK 4
Sweden SEMKO 1
Switzerland SEV 1
Taiwan BSMI 4
The United Kingdom BSI 1
The United States uL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm?2 conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm2 conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm? conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.
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10 Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general
household waste. Follow the local laws and regulations in your area for computer battery disposal.

Display

/A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

A CAUTION: The procedures in this chapter can result in damage to display components. The only
components intended for recycling purposes are the liquid crystal display (LCD) panel and the
backlight. When you remove these components, handle them carefully.

Ef NOTE: Materials Disposal. This HP product contains mercury in the backlight in the display
assembly that might require special handling at end-of-life. Disposal of mercury may be regulated
because of environmental considerations. For disposal or recycling information, contact your local
authorities, or see the Electronic Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be
disassembled to gain access to the backlight (1) and the liquid crystal display (LCD) panel (2).

99—

B’ NOTE: The procedures provided in this chapter are general disassembly instructions. Specific details,
such as screw sizes, quantities, and locations, and component shapes and sizes, can vary from one
computer model to another.

Baoftery 131


http://www.eiae.org

Perform the following steps to disassemble the display assembly:

1. Remove all screw covers (1) and screws (2) that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges (1) and the top and bottom inside edges (2) of
the display bezel until the bezel disengages from the display assembly.

3. Remove the display bezel (3).
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4. Disconnect all display panel cables (1) from the display inverter and remove the inverter (2).

5. Remove all screws (1) that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly (2) from the display enclosure.

7. Turn the display panel assembly upside-down.

8. Remove all screws that secure the display panel frame to the display panel.

9. Use a sharp-edged tool to cut the tape (1) that secures the sides of the display panel to the display
panel frame.
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10. Remove the display panel frame (2) from the display panel.

11. Remove the screws (1) that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover (2) and swing it outward.

—0

13. Remove the backlight cover.

14. Turn the display panel rightsside up.
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15. Remove the backlight cables (1) from the clip (2) in the display panel.

16. Turn the display panel upside-down.

A WARNING! The backlight contains mercury. Exercise caution when removing and handling the
backlight to avoid damaging this component and causing exposure to the mercury.

17. Remove the backlight frame from the display panel.
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18. Remove the backlight from the backlight frame.

19. Disconnect the display panel cable (1) from the LCD panel.
20. Remove the screws (2) that secure the LCD panel to the display rear panel.
21. Release the LCD panel (3) from the display rear panel.

22. Release the tape (4) that secures the LCD panel to the display rear panel.

24. Recycle the LCD panel and backlight.
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A
AC adapter
spare part numbers 31
AC adapter light, identifying 14
AC adapter, identifying 19
AMT options
AMT setup prompt (Ctrl-P)
firmware progress event
support. 104
firmware verbosity 104
initiate Intel CIRA 104
termiinal emulation mode
unconfigure AMT on next
boot 104
USB key provisioning
support 104
antenna, disconnecting 59, 60
applications key, Windows 12
audio board
removal 85
spare part number 22, 85
audio, product description 3
audio-in (microphone) jack
identifying 13
pin assignments 124
audio-out (headphone) jack
identifying 13

104

104

pin assignments 124
B
backing up
Windows 7 112
Windows Vista 116

Windows XP 121
Backup and Restore
Center 113,116,117
Base Cable Kit
contents 28
spare part number 28

base enclosure
spare part number 25
battery
removal 45
spare part number 45
battery bay 16
battery release latches,
identifying 16
battery, identifying 19
bays, battery 16
BIOS administrator password 99
Blu-ray Disc ROM Combo Drive
removal 51
spare part number 25, 30, 51
specifications 111
Bluetooth module
removal 82
spare part number 23, 82
Bluetooth module cable,
illustrated 28
boot options 100
boot order 100
broadband module
spare part number 24
built-in device
ambient light sensor
audio device 103
bay device 103
Bluetooth device
fingerprint reader
infegrated camera
internal speakers
microphone 103
modem 103
Network Interface Controller
(LAN) 103
options 103
power monitor circuit

Wake on LAN 103

103

103
103
103
103

103

wireless button 103

WLAN device 103

WWAN device 103
buttons

power 11

C

cables, service considerations 39

caps lock light, identifying 10
chipset, product description 1
components

additional hardware 19

bottom 16

display 16

front 13

leftside 15

rightside 13

top 8

wireless antennas 18
computer feet

locations 44

spare part number 44
Computer Setup

accessing 95

File menu 97

navigating and selecting 95

restoring factory settings 96
Security menu 99
System Configuration
menu 100
using 95
computer specifications
connector, power 14
connectors, service
considerations 39
cord, power 19

105

D
DC-in cable, illustrated 28
device configurations 101

Index
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discs
Driver Recovery 122
Operating System 122
Disk Sanitizer 99
diskette drive
precautions 39
product description 3
display assembly
removal 71
spare part numbers
display bezel
removal 73
spare part number 26
display component recycling 131
display enclosure
spare part number 27
Display Hinge Kit
spare part number 26
Display Hinge Kit, spare part
number 75
display panel
removal 75
display specifications 107
drive light, identifying 13
Drivelock
automatic 99
password 99
Driver Recovery disc 122
drives
boot order 100
optical 14
preventing damage 39
DVD-ROM Drive
removal 51
spare part number 51
specifications 109
DVD+RW Double-Layer Drive with
LightScribe
precautions 39
removal 51
spare part number 25, 30, 51
specifications 110

21,71

E
e/SATAUSB port

identifying 15
electrostatic discharge 40
esc key, identifying 12
Ethernet, product description 3
Execution disable 101
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ExpressCard slot bezel,
illustrated 27
ExpressCard slot, identifying 15
external media cards, product
description 4
external monitor port
identifying 15
pin assignments 125

F
f11 recovery
feet
locations 44
spare part number 44
File menu 97
finger print reader, product
description 4
fn key, identifying 12
function keys, identifying 12

115,119

G

graphics, product description 1

grounding equipment and
methods 42

H
hard drive

precautions 39

product description 2

removal 69

spare part

numbers 25, 30, 69

specifications 108
hard drive bracket, removal 70
hard drive recovery 115, 119
HDMI port, pin assignments 126
headphone (audio-out) jack

pin assignments 124
heat sink

removal 61

spare part number 61
hinge, spare part number 75
HP Quicklook 102
HP QuickLook light,

identifying 10
HP QuickWeb light,
identifying 10

|
internal display switch,
identifying 11, 17

internal microphone,

identifying 17

J

jacks
audio-in (microphone) 13
audio-out (headphone) 13
RI-11 (modem) 14
RJ-45 (network) 15

K
keyboard
product description 4
removal 46
spare part number 22, 36, 46
keypad keys, identifying 12

keys
esc 12
fn 12
function 12
keypad 12

Windows applications 12
Windows logo 12

L
language, changing in Computer
Setup 100

latches, battery release 16
LCD Cable

contents 29

spare part number 29
left TouchPad button 8
legacy support, USB 95, 101
lights

AC adapter 14

caps lock 10

drive 13

HP Quicklook 10

HP QuickWeb 10

optical drive 14

power 10
Quicklook 10
QuickWeb 10

TouchPad off indicator 10
webcam 17
wireless 10

M
mass storage devices, spare part
numbers 30



Media Card Reader,
identifying 13

memory module

product description 2

removal 50

spare part numbers 24, 50
microphone (audio-in) jack

identifying 13

pin assignments 124
Misc LCD Cable Kit

contents 29

spare part number 29
model name 1
modem jack, pin

assignments 127

modem module

product description 3

removal 83

spare part numbers 24, 83
monitor port

external 15

pin assignments 125
Multi Core CPU 102

N

network jack, pin
assignments 128

Num lock state 102

o
Operating System disc 122
operating system, product
description 4
optical drive
identifying 14
precautions 39
product description 2
removal 51
spare part number 25, 30, 51
specifications 109, 110, 111
optical drive bezel, illustrated 27
optical drive light, identitying 14

P
packing guidelines 41
palm rest
removal 67
spare part number 22
spare part numbers 67
panels, product description 1
passwords 99

pin assignments
audio-in jack 124
audio-out (headphone)
jack 124
external monitor port 125
HDMI 126
headphone (audio-out)

jack 124
microphone (audio-in)
jack 124

modem jack 127
monitor port 125
network jack 128

RI11 127

RJ-45 (network) jack 128
Universal Serial Bus (USB)

port 128
plastic parts 38
Plastics Kit

contents 27
spare part number 27
pointing devices, product
description 4
port options
1394 port 104
eSATA port 104
ExpressCard slot 104
flash media reader 104
parallel port 104
serial port 104
USB port 104
ports
eSATA/USB 15
external monitor 15
HDMI 15
product description 4
USB 14,15
power button board
removal 53
spare part number 22
power button, identifying 11
Power connector assembly
removal 93
spare part number 93
power connector, identifying 14
power cord
set requirements 129
spare part numbers 31, 33
power cord, identifying 19
power light, identifying 10

power requirements, product

description 4

pprocessor

product description 1
removal 65
spare part numbers 24, 65

product description

audio 3

chipset 1

diskette drive 3
Ethernet 3

external media cards 4
fingerprint reader 4
graphics 1

hard drives 2
keyboard 4
memory module 2
modem module 3
operating system 4
optical drives 2
panels 1

pointing devices 4
ports 4

power requirements 4
processors |
product name 1

security 4
serviceability 7
wireless 3

product name 1

Q
Quicklook light, identifying 10
QuickWeb light, identifying 10

recovery partition 115, 119
release latches, battery 16
removal/replacement

preliminaries 38
procedures 43

restore factory settings 97

restore security defaults 97, 104
restoring the hard drive 115, 119
rightTouchPad button 9

RJ-11 (modem) jack

identifying 14
pin assignments 127
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RJ-11 connector assembly
removal 91
spare part number 91
RJ-11 jack cable
illustrated 28
RJ-45 (network) jack
identifying 15
pin assignments 128
RTC battery
removal 80
spare part number 24, 37, 80

S
SATA (Serial Advanced Technology
Attachment) devices
AHCI (Advanced Host Controller
Interface) 101
IDE (Integrated Drive
Electronics) 101
SATA (Serial Advanced Technology
Attachment) devices) 101
Screw Kit
spare part number 32
security cable slot, identifying 15
Security menu
antitheft Protection 99
Automatic Drivelock 99
change password 99
Disk Sanitizer 99
Drivelock 99
f fingerprint reader reset 99
HP SpareKey 99
HP SpareKey enrollment 99
password policy 99
set up BIOS administrator
password 99
System IDs 99
user management 99
security, product description 4
service considerations 38
service tag, location 20, 43
serviceability, product
description 7
set security level
setup utility
File menu 97
navigating and selecting 95
restoring factory seftings 96

104

140  Index

Security menu 99
System Configuration
menu 100
SIMslot 16
slots
ExpressCard 15
security cable 15
speakers
identifying 11
removal 55
spare part number 22, 55
specifications
Blu-ray Disc ROM Combo
Drive 111
computer 105
display 107
DVD-ROM Drive 109
DVD+RW Double-Layer Drive
with LightScribe 110
hard drive 108
optical drive 109, 110, 111
static-shielding materials 42
switch cover
removal 46
spare part number 22, 46
system board
removal 87
spare part numbers 23, 87
system board assembly, spare part
number 23
System Configuration menu
system date and time 97
system diagnostics 97
system fan 101
system IDs 99
system information 97

100

T
thermal material, replacement 63
thermal shield

removal 56

spare part number 56
tools required 38
top cover

removal 77

spare part number 22, 77
TouchPad, identitying 8
TouchPad, light 8
transporting guidelines 41

U
Unified Extensible Firmware
Interface (UEFI) mode 102

USB connector assembly

removal 90

spare part number 90
USB legacy support 95, 101
USB port

identitying 14, 15

pin assignments 128

\"
vents, identifying 15
Virtualization Technology 102

w
wake on USB 102
webcam light, identifying 17
webcam module
spare part number 26
webcam, identifying 17
Windows 7 operating system
DVD 115
Windows applications key,
identifying 12
Windows Backup and
Restore 112
Windows Backup
utility 121, 122
Windows logo key,
identifying 12
Windows
recovery 114,118, 122
Windows Vista operating system
DVD 119
wireless antenna,
disconnecting 59, 60
wireless light, identitying 10
wireless, product description 3
WILAN antennas, identifying 18
WILAN module
removal 58
spare part numbers 23, 58
workstation guidelines 41
WWAN antennas, identifying 18
WWAN module
removal 59
spare part number 59
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